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Foreword
This manual describes the functions and operating procedures of GateCONTROL. To 
ensure correct use, please read this manual thoroughly before beginning operation. After 
reading the manual, keep it in a convenient location for quick reference in the event a 
question arises.
GateCONTROL is a software driver that uses the Modbus/RTU or Modbus/TCP protocol 
to acquire data from Yokogawa temperature controllers, signal conditioners, and other 
instruments, and then transfer that data to DAQLOGGER or Remote Monitor. 

Note
•	 The contents of this manual are subject to change without prior notice as a result of 

improvements in the software’s performance and functions.
•	 Every effort has been made in the preparation of this manual to ensure the accuracy 

of its contents.  However, should you have any questions or find any errors, please 
contact the dealer from whom you purchased the software. 

•	 Copying or reproducing all or any part of the contents of this manual without the 
permission of Yokogawa Electric Corporation is strictly prohibited.

•	 Use of this software on more than one computer at the same time is prohibited. Use 
by more than one user is also prohibited.

•	 Transfer or lending of this software to any third party is prohibited.
•	 Yokogawa Electric Corporation provides no guarantees other than for physical 

deficiencies found on the original disk or this manual upon opening the product 
package.

•	 License numbers will not be reissued. Please keep the license number in a safe 
place.

Copyrights
•	 Copyrights for the programs included on the CD-ROM are attributable to Yokogawa 

Electric Corporation.  

Trademarks
•	 DAQWORX, DAQLOGGER, and DAQEXPLORER are registered trademarks or 

trademarks of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
•	 The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revisions
•	 1st Edition	 	 February 2005
•	 2nd Edition		 August 2005
•	 3rd Edition		 June 2007
•	 4th Edition		 January 2009
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric Corporation (hereinafter called 
“Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the “Yokogawa Software Program”).
By installing the Yokogawa Software Program, you acknowledge that you understand and fully agree to the “Terms and Conditions of the Software License” (hereinafter called 
“Terms and Conditions”) which is written in the documentation and separately attached. Accordingly, the Terms and Conditions bind you.
The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa or those third parties who 
grants Yokogawa the rights.
Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions before you install it in or onto 
a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT INSTALL THIS MEDIUM, AND MUST PROMPTLY RETURN IT TO YOKOGAWA OR ITS 
DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program (hereinafter called the 
“Licensed Software”) to you on the conditions that you agrees to the terms and conditions stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions on the software license (hereinafter called the “Agreement”) when the 
Licensed Software is installed by the Licensee.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall Yokogawa intend to 
sell or transfer the Licensed Software to the Licensee.

Article 1 (Licensed Software under these Terms and Conditions)
1.1	The terms and conditions stipulated herein shall bind any Licensee who purchases the Licensed Software on the condition that the Licensee consents to agree to the 

terms and conditions stipulated herein.
1.2	The “Licensed Software” and required number of license herein shall be specified in the following paragraphs (1) and (2) respectively. The Licensed Software means and 

includes all applicable programs and documentation, without limitation, all proprietary technology, algorithms, a factor, invariant, process and/or other know-how contained 
therein. These terms and conditions shall also govern any additional software to the Licensed Software inclusive of its version-up or revision-up if Yokogawa provides them 
to the Licensee.

(1)	Licensed Software Name: Data Acquisition Software Suite DAQWORX
(2)	Number of License: Same number as those media for the Licensed Software shall be acquired for installation.

Article 2 (Grant of License)
2.1	Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the license fee separately agreed 

upon by both parties.
2.2	The Licensee is, unless otherwise agreed upon in writing by Yokogawa, not entitled to change, sell, distribute, transfer, or sublicense the Licensed Software.
2.3	The Licensed Software shall not be copied in part or in whole except for keeping one (1) copy for back-up purpose. The Licensee shall secure or supervise the copy of 

the Licensed Software by the Licensee itself with great, strict, and due care.
2.4	The Licensed Software remains the exclusive property of Yokogawa and, if any, those of third parties from whom Yokogawa is sublicensed (hereinafter such third party’s 

software is called “Third Party Software”, which may include any software program made or coded by affiliates of Yokogawa). In no event shall the Licensee dump, reverse 
assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may translate the Licensed Software into other programs or change it into a 
man-readable form from the source code of the Licensed Software. Unless otherwise separately agreed upon by Yokogawa, Yokogawa shall not provide the Licensee the 
source code for the Licensed Software.

2.5	The Licensed Software and its related documentation inclusive of its ownership of copyright shall be the proprietary property of Yokogawa or a third party who grants 
Yokogawa the rights. In no event shall the Licensee transfer, lease, sublicense, or assign any rights relating to the Licensed Software.

2.6	Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall, regardless of the purpose, the Licensee remove or attempt to remove such 
copy protection.

2.7	The Licensed Software may include the Third Party Software. In the case that Yokogawa is granted permission to sublicense to third parties by any licensors (sub-licensor) 
of the Third Party Software under different terms and conditions than those stipulated in this  Agreement, the Licensee shall observe such terms and conditions of which 
Yokogawa notifies the Licensee in writing separately.

2.8	In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1	The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the purpose of the following 

events:
a)	 Operation of any aviation, vessel, or support of those operations from the ground;
b)	 Operation of nuclear products, its facilities and/or radiation apparatus;,
c) 	Operation of nuclear weapons, chemical weapons and/or biological weapons, or railroad; or
d)	 Operation of medical instrumentation directly utilized for humankind or the human body.

3.2	Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility for any claims or damages 
arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to solve and settle the claims and damages and to defend, 
indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable 
attorney’s fees and court costs), or claims arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1	The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such as damage to the medium of 

the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed Software on condition that the defective Licensed 
Software shall be returned to Yokogawa’s specified authorized service facility within  12 month from the delivery of Yokogawa after opening the Package at the Licensee’s 
expense. As the Licensed Software is provided to the Licensee on an “as is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the 
Licensed Software, including without limitation, data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2	Notwithstanding the preceding Paragraph 4.1, when Third Party Software is included in the Licensed Software, the warranty period and related conditions that apply shall 
be those established by the provider of the third party software.
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4.3	When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Release Upgrades specified by Yokogawa 
(hereinafter called “Release Upgrades”).

4.4	Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted renovation or improvement 
of the Licensed Software.

4.5	Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any failure of Yokogawa to 
comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the Third Party Software to Yokogawa (including any 
liability for direct, indirect, special, incidental or consequential damages) whether in warranty, contract, tort (including negligence but excluding willful conduct or gross 
negligence by Yokogawa) or otherwise with respect to or arising out of the use of the Licensed Software.

4.6	THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, WRITTEN, ORAL, OR 
IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA.

Article 5 (Infringement)
5.1	If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under patent right (including utility 

model right, design patent, and trade mark), copyright, and any other rights relating to any of the Licensed Software, the Licensee shall promptly notify Yokogawa in writing 
to that effect.

5.2	In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with the claiming party. 
Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s defense and negotiation. If and when such a claim 
should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate 
with the claiming party at Yokogawa’s cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 
5.1.

5.3	When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s judgment there is possibility of 
such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at Yokogawa’s cost and expense.

a)	 To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the Licensed Software;
b)	 To replace the Licensed Software with an alternative one which avoids the infringement; or
c)	 To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4	If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall indemnify the Licensee 
only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee. 

	 THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA 
WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1	If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to the Licensee under the 

conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this Agreement. However, in no event shall Yokogawa be 
liable or responsible for any special, incidental, consequential and/or indirect damage, whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, 
without limitation, loss of operational profit or revenue, loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of 
interruption of the Licensee’s business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of 
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the extent of this 
Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which Yokogawa has received. The 
Licensee agrees that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the Licensee modifies, remodels, combines with 
other software or products, or causes any deviation from the basic specifications or functional specifications, without Yokogawa’s prior written consent.

6.2	All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless Yokogawa is notified of the claim 
within one (1) year of its occurrence.

6.3	In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between the Licensee and its 
customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than those where Yokogawa 
permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until terminated as provided herein, 
or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to the Licensee. When aforesaid termination or cease is 
occurred, the Licensee shall immediately destroy and/or eliminate the Licensed Software and related documents without retaining any copies or extracts thereof. However, 
upon specifically instructed by Yokogawa, they shall be returned to Yokogawa or its designated third party.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems that the Licensed Software is 
used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to perform this Agreement. 
However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably through negotiation 
between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after notice from one of the parties to the other, both parties hereby 
irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for settlement of the dispute to the fullest extent allowed by applicable law.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and irrevocably and to the 
fullest extent permissible under applicable law any rights against the laws of Japan which may have pursuant to the Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to 
the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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Overview of This Manual

Structure of The Manual
This user’s manual consists of the following chapters. 
Chapter Title Description
1 Overview Gives an overview of the GateCONTROL software. Lists the PC 

requirements for running GateCONTROL and gives information 
about system configuration. 

2 Operating Gives procedures for entering environment and data acquisition.  
Procedures interval settings, and how to monitor the operational 
status of the software. 

3 Functions Provides a detailed description of the functions of GateCONTROL.  
Lists error messages, their causes, and their corrective actions.

Index An alphabetical index of the manual’s contents.

Scope of the Manual
This manual provides instructions on how perform basic operations with the software 
when running under Windows XP, Windows 2000, and Windows Vista. For information 
regarding the basic operations of Windows, see the Windows user’s manual.

Conventions Used in This Manual
•	 Units
	 K 	Denotes 1024.	 Example: 10 KB
	 M 	Denotes 1024K.	 Example: 10 MB
	 G	 Denotes 1024M.	 Example: 2 GB

•	 Boldface Type
	 Hardware and software controls that the user manipulates such as dialog boxes, 

buttons, and menu commands are often set in boldface type.
	
•	 Subheadings
	 On pages in chapters 1 through 3 that describe operating procedures, the following 

subheadings are used to distinguish the procedure from their explanations.

			 

Procedure This subsection contains the operating procedure used to carry out
the function described in the current section. All procedures are
written with inexperienced users in mind; experienced users may
not need to carry out all the steps.

			   Note Calls attention to information that is important for proper operation 
of the instrument.



�IM WX1-07E

1

2

3

Index

Contents

Terms and Conditions of the Software License................................................................................. ii
Overview of This Manual.................................................................................................................. iv

Chapter 1	 Overview
1.1	 Overview of GateCONTROL Functions................................................................................ 1-1
1.2	 System Overview.................................................................................................................. 1-2

Chapter 2	 Operating
2.1	 Running and Exiting GateCONTROL................................................................................... 2-1

Running the Software........................................................................................................... 2-1
Exiting the Software.............................................................................................................. 2-1

2.2	 Entering Environment Settings............................................................................................. 2-2
Serial Port Settings (When the Communication Mode is COM)........................................... 2-2
Data Acquisition Conditions.................................................................................................. 2-5
TCP/IP Settings for the Monitor Server Port......................................................................... 2-5
Tag Settings.......................................................................................................................... 2-6

2.3	 Saving and Restoring Environment Settings.......................................................................2-11
Saving Environment Settings...............................................................................................2-11
Restoring Environment Settings..........................................................................................2-11

2.4	 Starting/Stopping Data Acquisition..................................................................................... 2-12
Starting Data Acquisition .................................................................................................... 2-12
Stop data acquisition.......................................................................................................... 2-13

2.5	 Performing Communication Tests of Connected Devices................................................... 2-14
Performing the Loop Back Test .......................................................................................... 2-14
Performing Read and Write Tests....................................................................................... 2-14

2.6	 Checking the Client Connection Status and Communication Status of Connected Instruments, 
and Reconnecting Connected Instruments ........................................................................... 2-16
Checking the Client Connection Status and Communication Status of Connected 
Instruments......................................................................................................................... 2-16
Reconnecting Connected Instruments................................................................................ 2-17

2.7	 Viewing Version Information............................................................................................... 2-18

Chapter 3	 Functions
3.1	 Modbus Communication Device Settings............................................................................. 3-1

Settings for Connected Modbus Devices ............................................................................. 3-1
3.2	 Meanings of Tags of Connected Devices............................................................................. 3-2
3.3	 Details on Functions............................................................................................................. 3-4

Time Out Operation.............................................................................................................. 3-4
Error Status........................................................................................................................... 3-5
Processing Alarm Statuses................................................................................................... 3-6
Output Processing................................................................................................................ 3-8

3.4	 Notes When Performing Communications with Software on Other PCs.............................. 3-9
Communications with DAQLOGGER................................................................................... 3-9
Communications with DAQLOGGER Client Package.......................................................... 3-9
GateCONTROL Settings....................................................................................................... 3-9



vi IM WX1-07E

Contents

3.5	 Error Messages and Corrective Actions............................................................................. 3-10
Error.................................................................................................................................... 3-10
Message............................................................................................................................. 3-10
Messages during (When Executing) Data Acquisition ....................................................... 3-10

Index



1-1IM WX1-07E

1

2

3

Index

O
verview

Chapter 1	 Overview

1.1	 Overview of GateCONTROL Functions

GateCONTROL is a software driver that acquires data from temperature controllers and 
signal conditioners that support data input/output via the Modbus/RTU and Modbus/
TCP protocols, and in addition to transferring the data to Yokogawa's DAQLOGGER or 
Remote Monitor software, can write output requests from AddObserver to temperature 
controllers. Using GateCONTROL allows you to easily monitor data on DAQLOGGER 
or Remote Monitor that is input for measurement on temperature controllers and signal 
conditioners. Also, it is now possible to operate a controller from AddObserver through 
GateCONTROL. 

DAQLOGGER is application software for the PC that enables communication between 
the PC and various types of recorders as well as monitoring of data logged by those 
recorders. A direct connection can be made for communications between DAQLOGGER 
and the µR1000/µR1800, VR, DARWIN, DX, MV, and CX recorders by Yokogawa.  
Remote Monitor is application software that enables monitoring of data logged by 
recorders or data logging software.
AddObserver is a software program that allows the user to create original screens for 
displaying measured data, and for operating instruments.  

Features
•	 Up to thirty-two temperature controllers and signal conditioners can be connected. 
•	 The main registers of each instrument are automatically assigned as tag information 

using the Automatic Model Determination function.  
•	 Arbitrary registers can be registered as tags.  
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1.2	 System Overview

System
This software can open communication with Yokogawa temperature controllers and 
signal conditioners, perform data acquisition, and write the data.  
The supported temperature controllers and signal conditioners are the ones below 
that support the Modbus/RTU or Modbus/TCP protocol. The product may not support 
GateCONTROL depending on its firmware revision number. For information on how to 
check the firmware revision number of your MODBUS instrument, and whether or not a 
connection with GateCONTROL can be made, please contact the dealer from which you 
purchased the instrument.

Temperature controllers UT130, UT150, UT152, UT155, UP150
Digital indicating controllers UT320, UT321, UT350, UT351, UT420, UT450, UT520, 

UT550, UT551, UT750, US1000
Program controllers UP350, UP351, UP550, UP750
Digital indicators with alarms UM330, UM331, UM350, UM351
Signal conditioners and conditioners VJA7, VJH7, VJP8, VJQ7, VJQ8, VJS7, VJU7, VJX7
Digital alarm configurators MVHK, MVRK, MVTK

Supported Operating Systems
Run DAQWORX under any of the following operating systems. 
•	 Windows 2000 Professional SP4
•	 Windows XP Home Edition SP2, SP3
•	 Windows XP Professional SP2, SP3 (excluding Windows XP Professional x64 Edition)
•	 Windows Vista Home Premium, SP1 (excluding the 64-bit edition)
•	 Windows Vista Business, SP1 (excluding the 64-bit edition)
The language displayed by the software under different language versions of the OS are 
as follows. 

OS Language Software Language
Japanese Japanese
Other English
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1.2  System Overview

Hardware Requirements
The following hardware and software are required to use GateCONTROL. 
•	 PC:						�      A PC that runs one of the OS above, and that meets the 

following CPU and memory requirements. 
								        When Using Windows 2000 or Windows XP
								�        Pentium 4, 1.6 GHz or faster				  

512 MB or more of memory
								        When Using Windows Vista
								        Pentium 4, 3 GHz or faster
								        2GB or more of memory
•	 Free disk space: 	 200 MB or more
•	 Communication interface:
								�        An Ethernet (when connecting to DAQLOGGER or Remote 

Monitor) or RS-232 port that is recognized by the operating 
system. 

•	 CD-ROM drive:		  Used to install the software.
•	 Peripheral devices:	 A mouse supported by the operating system.
•	 Monitor:					    When Using Windows 2000 or Windows XP
								�        A monitor supported by the OS of 1024 × 768 dot or higher and 

65,536 colors or more.
								        When Using Windows Vista
								�        A video card recommended for use with Vista and a monitor 

supported by the OS of 1024 × 768 dot or higher and 65,536 
colors or more.

Note
An RS-232 to RS-485 converter is required to perform communications between the software 
and another Modbus/RTU (RS-485) device (Yokogawa ML2 RS232C/RS485 converter 
recommended). 
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System Configuration

Up to 32 units

AddObserver

DAQLOGGERGateCONTROL

Remote Monitor
TCP/IP connection

Monitor server protocol
Data transfer

TCP/IP connection
Monitor server protocol

Data transfer

VJET
Ethernet/RS-485
converter

ML2
RS-232C/RS-485
Converter

RS-485 RS-485

RS-232

Ethernet

RS-485

JUXTA VJ Series
Signal Conditioners 
(with communication function)

Green Series
Digital Indicating Controllers 
(with communication option)

UT351-xA
Digital Indicating 
Controller (with 
Ethernet communications)

JUXTA M series
Digital Alarm Configurators
(with communication function)

1.2  System Overview
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Chapter 2	 Operating

2.1	 Running and Exiting GateCONTROL

Running the Software
Procedure

1.	 From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX > 
GateCONTROL > GateCONTROL.

	 GateCONTROL starts. 

Note
•	 When you start GateCONTROL it is restored to the same status that was active during the 

previous session. 
•	 If the program is closed while a process or service is running, the license will be considered 

to be “in use.” If the message, “Invalid license number. Please reinstall.” appears when 
restarting the program, it may indicate that the user is attempting to run a Gate program in 
excess of the number of available licenses.

Exiting the Software
Procedure

1.	 Choose File > Exit from the menu bar, or click the X button at the right end of the 
title bar. 

	 GateCONTROL closes. 
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2.2	 Entering Environment Settings

This software includes an automatic model determination function, enabling automatic 
acquisition of the connected devices' (temperature controllers and signal conditioners) 
model names, tag information, and Modbus address when you enter the appropriate 
serial port settings, IP addresses, and/or port numbers. 
The following environment settings are entered. 
•	 Serial port settings (when the communication mode is COM)
•	 Settings for the connected devices
•	 Data acquisition condition
•	 TCP/IP port settings for the monitor server
•	 Tag settings (enter the tag name and decimal place as needed)

Serial Port Settings (When the Communication Mode is COM)
Procedure

1.	 Click the Serial Setting tab or choose View > Serial Setting from the menu bar. 

	 The Serial Setting page in displayed. 

					     Copies the setting 
in the first item of 
the selection to all 
of the items in the 
selection

Turns selected range ON/OFF collectively

Drag to select 
a range of items

Click to turn a single item ON/OFF

Click to 
select/clear
all rows Click to display a 

list of options

2.	 Turn ON the port numbers to be used, and set the baud rate, and parity. 

	 Port number: 	 ON (blue)/OFF (gray)

	 Baud rate: 	 4800, 9600

	 Parity: 		  NONE, ODD, EVEN
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Settings for the Connected Devices
Register all devices that you will operate and from which you will acquire data.  

Procedure
1.	 Click the Model tab or choose View > Model from the menu bar. The Model 

Setting tab is displayed.

Drag to select a range 
of items

Copies the setting in the first item of the selection 
to all of the items in the selection

Click to display a list box for selecting a communication port
Only enabled COM ports (specified in serial port settings) are displayed

When Ether communication is selected, clicking here displays a dialog box 
for setting the IP address, port number, and Modbus address.  
If COM1-COM9 is selected, a dialog box for setting the Modbus address appears. 

2.	 Select the port to be used from the Communication Method list box.  
	 If using an Ethernet port:	 Ether
	 If using a COM port:	 COM1–COM9

IP Address and Port Number (If Ethernet Is Selected for the Port)
3.	 Click an address. The Address Setting dialog box opens.

					   

4.	 Enter the IP address (or host name) and port number. 
	 IP address:	� Enter the IP address or host name set on the device to which 

you wish to connect.
	 Port no.:		  502
	 Modbus address:	 1–9
	 (If you will perform automatic model determination, including for the 

Modbus address, select Unknown.)

Note
The default port number for Modbus/TCP is 502. If no particular specification has been made 
on the device, use this number.  

2.2  Entering Environment Settings
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2.2  Entering Environment Settings

Modbus Address (for Ports Set to COM)
3. 	 Click an address. The Address Selection dialog box opens.

					   

4.	 Enter the Modbus address. 

	 Modbus address:	 1–99

	 If you will perform automatic model determination including for the Modbus 
address, choose Unknown. 

Automatic Model Determination
5.	 After specifying the communication methods and addresses, drag numbers to 

specify the range for automatic model determination.  

Automatic detection button

Clears the contents of 
the status boxes.

Drag to select a range for automatic model determination.

6.	 Click the Automatic detection button at the bottom of the screen, click the 
Automatic determination button in the toolbar, or choose Communication > 
Automatic detection from the menu bar. 

	 Model name, control mode, control output, option functions, and tag information 
is automatically acquired.  A loop back test is also executed at the same time.  
If the test concludes without errors, a status of “OK” is displayed.  (“Not OK” is 
displayed if an abnormality occurred.)  
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Note
•	 If you connect to an unsupported devices, “Unknown” is displayed for the model.  
•	 If the result, model name, control mode, control output or option functions found by 

automatic model determination differ, the tag list in the tag settings dialog box is initialized.  
If the tag list was modified from the initial condition, the message, “OK to initialize tag list?” 
is displayed.  

	 Click the Yes button to implement the search results and initialize the tag list.  Click the 
Cancel button to quit without applying the results of automatic model determination to the 
model settings page. 

Data Acquisition Conditions
Procedure

1.	 Click the Scan Interval Setting tab or choose View > Scan Interval Setting from 
the menu bar.

					   

Click to display a list

2.	 Set the acquisition interval, timeout time, and number of retries.

	 Acquisition interval:	 0.5–60 s (or 500–60000 ms: initial value is 5000 ms)

	 Timeout time:	 1–10 sec (or 1000–10000 ms: initial value is 1000 ms)

	 Retry ON/OFF:	 Select whether or not to retry communications (ON/OFF). 

	 Retry interval:	 The interval between communication retries (30–3600 sec.)

Note
•	 Retries are performed every scan interval at the specified retry interval until communication 

is restored. Retries are also performed on instruments with which a communication error 
occurred during the first communication. At the point that communication is restored, alarm 
values and other information are retrieved from the connected temperature controllers or 
signal conditioners and data is acquired. 

•	 If Retry is turned OFF, you can retry the connection manually by clicking the Retry 
Connection button on the Monitor/Status tab. 

TCP/IP Settings for the Monitor Server Port
The port number need not be changed unless desired. 

Procedure
1.	 Choose File > Port No. from the menu bar. 

	 The Port No. for the internal communication dialog box opens.

					   

2.	 Enter the port number used to transfer data loaded from a connected device to 
DAQLOGGER, Remote Monitor or AddObserver. 

2.2  Entering Environment Settings
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Tag Settings
Procedure

1.	 Click the Detail Settings in the tag information column of the model you wish to 
set in the Model Settings page.  

Click to Tag Setting dialog box

	 The Tag Setting dialog box opens.

	 One of the following tag names that was reserved is displayed.  

PV1 A/M1 R/P1/P2 TME1 TME11 C.A.M1
PV2 A/M2 HOLD TME2 TME12 C.A.M2
SP1 C.A.M PVE1 TME3 TME13 O/C
SP2 R/L1 PVE2 TME4 TME14 INPUT
OUT1 R/L2 PVE3 TME5 TME15 ADVANCE
OUT2 SPNO PVE4 TME6 TME16 RUN
HOUT1 PIDNO1 PVE5 TME7 PTNO
HOUT2 PIDNO2 PVE6 TME8 SEGNO
COUT1 R/S PVE7 TME9 TIME
COUT2 R/P/L PVE8 TME10 LSP/CAS

	 The tag settings include an input tab page and an output tab page.  

		 Maximum number of input tags: 48

		 Maximum number of output tags: 32

	 The active page is surrounded by a red frame.  You can click anywhere on an 
input/output tab page to move the red frame.  

	 The list of registered tags is determined by the model, control mode, control 
output, and option functions.  Default tag list items displayed in gray cannot be 
changed.  Also, the default tag list cannot be deleted. 

2.2  Entering Environment Settings
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2.	 If you performed automatic model determination, the tag information acquired 
from the connected devices is displayed.  

	 If links are set, the edited contents are reflected on the linked channels.  

	 Editing the Input Tag Page

					   

If the tag numbers are selected (blue), 
they are displayed as tag numbers in 
the Remote Monitor display groups

Select/clear all rows
The tab page to be set is 
surrounded by a red frame

Create input tags
Delete input tags

Tag No.:					    Select to use (blue) or not use (gray) the selected tag numbers.  
Register number:	 Shows the reference location of each register.  
							       Setting range: 40001 to 49999

						�      When Same on the Output tab page is ON (blue), the edited results 
are reflected on the output tab page.  Register numbers cannot be 
duplicated (duplicate register numbers are allowed for the default 
tags because the bit position of the referenced value is different).  

Tag name:				�   Specify using eight alphanumeric characters or fewer.  In the Remote 
Monitor, this is displayed as a channel name. 

							�       Tag names cannot be duplicated.  Also, tags to which reserved tag 
names have been added cannot be used.  

Tag comment:			  Specify using sixteen alphanumeric characters or fewer.  
							       In the Remote Monitor, this is displayed as a tag comment. 
Decimal point:		�  Set the decimal place to offset the register value.  Select 0, 1, 2, 3, 4, 

or 5. The initial values vary depending on the type of tag. If automatic 
model determination is performed, the decimal point of the connected 
device is displayed.  

Span minimum/maximum:
							       Setting range:	–1E16 to 1E16
							�       The initial values vary depending on the type of tag. If automatic 

model determination is performed, the setting value of the connected 
device is displayed.

							       On the client side this is handled as the minimum/maximum of scale.  
Units:					�     Specify using six alphanumeric characters or fewer.  The initial values 

vary depending on the type of tag. If automatic model determination 
is performed, the units set on the connected device are displayed.

Color:					�     Click the colored part to open the Color Settings dialog box. An 
arbitrary color can be entered.

Output link:			�   Displayed in the format xx:tag name where xx is the output tag number. 
							�       Displays the tag for output that is linked to the input tag. This cannot 

be changed.  

2.2  Entering Environment Settings
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	 Loaded value:	Displays the tag name value loaded from the connected device when 
the monitor is executed.  “Error” is displayed if a communication error occurs.  

Note
The tag number use/do not use settings are those of the ON/OFF display conditions of the 
Remote Monitor. 
The color setting is the display color of the Remote Monitor.  

Editing the Output Tab Page

		

Click here (blue) to apply the edited register numbers to the input tab page, 
or apply the edited register numbers to the input tab page.

Select/clear all rows
Used as the Tag No. in AddObserver

The tab page to be set is surrounded by a red frame

Click to display the Tag selection dialog box 

Create output tags

Tag No.:				   Used as Tag No. in AddObserver
Registers:			�   Same:When selected (ON), the output register number is applied 	

to the input register number. 
						�      No.:Shows the location of the tag write register.  However, since in the 

case of SP there are multiple registers to be written, a register number 
is not displayed.  Register numbers cannot be duplicated.  

Tag name:			  Specify using eight alphanumeric characters.  
						      Used as Channel Name in AddObserver. 
						�      Tag names cannot be duplicated.  Also, tags to which reserved tag 

names have been added cannot be used.  
Tag comment:		 Specify using sixteen alphanumeric characters or fewer.  
						      In AddObserver, this is displayed as a tag comment. 
Decimal point:	� Set the offsetting decimal place for writing to registers. Select 0, 1, 2, 3, 4, 

or 5. 
Span minimum/maximum	:
						      Setting range:	 –1E9 to 1E9
						�      If the value requested by AddObserver is outside of the span range, it is 

not output.  
Units:				    Specify using six alphanumeric characters or fewer.  

Note
Registers 41280 (UTM, USM, UPM) and 41281 (SMP) of the UT520, UT550, UT551, UT750, 
US1000, UP550, and UP750 cannot be written using the Modbus/RTU, Modbus/TCP protocol. 
Please make note of this. 

2.2  Entering Environment Settings
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Input link:			   Displays and selects the tag for intput that is linked to the output tag. 
						      Displayed in the format xx:tag name where xx is the input tag name. 
						�      When you click an input select button, the tag selection dialog box is 

displayed.  

										        

Input select button
Click here to display the Tag Selection dialog box.

Links are not set

Click here (blue) to apply the edited register numbers 
in the input tag to the output tag

Display the tag that links are not set of registered tags 
of the input tab page

Output value:		 Specifies an output value for the output test. 
								        Range:	 –1E9 to 1E9
Loaded value:		 The output register value is displayed after the output test. 
						�      If the output value is outside of the output span, “Out range” is 

displayed.  If a communication error occurs during output, “Com error” 
is displayed. 

2.2  Entering Environment Settings
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Tag Setting Execution Button
Insert input tags, insert output tags	:
						      Insert a tag in the last line of the tag numbers.  
						      Cannot be performed during testing. 
Delete input tags, delete output tags:
						�      Deletes the selected tag. If a tag is deleted, the tag numbers are 

refreshed. 
						      With deletion of input tags, the linked output tags are also deleted.  
						�      With deletion of output tags, the linked input tags are not deleted but the 

link is cleared.  
						      Default tags cannot be deleted. 
						      Cannot be performed during testing. 
Initialization:		�  Added tags are all deleted, and the tag list returns to the default 

condition. 
OK:					�     The settings in the tag settings dialog box are saved, and the dialog box 

closes.  
						�      When testing, the settings are saved after the test is completed, and the 

dialog box closes.  
						�      If register or tag names are duplicated, the dialog box below is 

displayed.  

										        

						      Duplicate register numbers and tag names are displayed in yellow. 

										        

2.2  Entering Environment Settings
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2.3	 Saving and Restoring Environment Settings

Saving Environment Settings
Procedure

1.	 Click the Save button or choose File > Save from the menu bar. 

Save button

	 The current settings are saved.

Restoring Environment Settings
This procedure clears all settings currently being entered and restores the most recently 
saved settings. 

Procedure
1.	 Choose File > Revert from the menu bar. 
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2.4	 Starting/Stopping Data Acquisition

When you start data acquisition using this software, data from connected devices 
(temperature controllers and signal conditioners) is loaded, transferred to DAQLOGGER 
or Remote Monitor, and output requests from AddObserver are written to connected 
devices.

Note
The maximum number of DAQLOGGERs, Remote Monitors, or AddObservers that can be 
connected at once is sixteen. 

Starting Data Acquisition 
Procedure

1.	 Enter environment settings. (See section 2.2, “Entering Environment Settings.”)

Running from the Toolbar/Menu Bar
2.	 Click the Start button or choose Monitor > Start from the menu bar. 

					   

Data acquisition Start button

	 The status of communication with the device is displayed in the Monitor/Status 
tab under Communication status.  Under Client status, the name of the connected 
client, connection status, and the address of any disconnected DAQLOGGERs,  
Remote Monitors, and AddObserver is displayed. 
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Starting (Executing) from the Monitor/Status Tab
2.	 Click the Start button on the Monitor/Status tab. 

	 The name of connected clients and their communication statuses are displayed. 

	 Maximum number of display of clients communication statuses is 48. 

					   

Turn ON (blue) to start data acquisition simultaneously 
upon software startup 

Stop button
Click to stop data acquisition

Start button
Click to start data acquisition 

Starting the Software and Data Acquisition at the Same Time
3.	 When you turn ON “Start monitor at startup” in the Monitor/Status tab, data 

acquisition starts at the same time that the software is started.  

Stop data acquisition
Procedure

Stopping Acquisition from the Toolbar/Menu Bar
1.	 Click the Stop button or choose Monitor > Stop from the menu bar. 

	 Nothing is displayed for the communication of connected devices.

					   

Data acquisition Stop button

Stopping Acquisition from the Monitor/Status Tab
1.	 Click the Stop button on the Monitor/Status tab. 

	 Nothing is displayed for the communication of connected devices. 

2.4  Starting/Stopping Data Acquisition
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2.5	 Performing Communication Tests of 
Connected Devices

Before starting data acquisition, you can perform a loop back test, read test, and write 
test between connected devices.  

Performing the Loop Back Test 
Using the loop back test you can check the specified communication method and 
connection status with the device at the specified address.  

Note
The loop back test can not be performed during data acquisition.  

Procedure
1.	 Click the Model tab or choose View > Model from the menu bar. 
	 The Model  tab is displayed. 

Select/clear all items

Drag to select a range for collective setting 
or the loop back test

Click to clear the 
contents of the status

Result appears
OK: Normal
Not OK: No response

2.	 Drag to select the numbers on which you wish to perform the loop back test. 
3.	 Click the Loop Back Test button. 
	 The result appears in the status column.
		 OK: 	 Normal
		 Not OK: 	No response

Note
•	 If the result is Not OK, check whether the communication settings of the software and target 

device match.  
•	 If the loop back test will be performed on multiple devices, individual tests are performed 

even if a communication error occurs part way through. 

Performing Read and Write Tests
You can check the data of the registers specified in the input tab page (monitor 
execution) by performing a read test.  
Also, you can perform a write test to the registers specified in the output tab page during 
monitor execution.  
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Note
The Read and Write tests cannot be performed during data acquisition. 

Procedure
Performing a Read Test

1.	 Click the Detail Settings button in the Model Settings tab page of the model on 
whicih you wish to perform the read test. 

	 The Tag Setting dialog box opens.

Click to display the Tag Settings dialog box
 

Monitor Stop and Output Test Buttons

Monitor execution 
results

Output test 
results

Specifies the output 
values during the 
output test

Drag to select the tag on which 
to perform the output test

Monitor start button

2.	 Click the Start monitor button.  

	 The value of each tag from the instrument is loaded, and displayed in the loaded 
value column of the input tab sheet.  

	 To quit monitor execution, proceed to step 6.  
Performing a Write Test

3.	 Specify the Output Values of the tags on which you wish to perform the output 
test in the output tab page. 

4.	 Select the tags on which to perform the output test

5.	 Click the Output Test button.  

	 The output values are written to registers, then the values are acquired from the 
write registers and the loaded results are displayed in the loaded value column in 
the output tab page. 

Stopping the Read Test
6.	 Click the Stop monitor button.  

	 The Read Test is concluded. 

2.5  Performing Communication Tests of Connected Devices
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2.6	 Checking the Client Connection Status and 
Communication Status of Connected Instruments, 
and Reconnecting Connected Instruments 

Checking the Client Connection Status and Communication Status of Connected 
Instruments

Procedure
Checking the Connection Status

1.	 Click the Monitor/Status tab or choose View > Monitor/Status from the menu 
bar. The Monitor/Status tab is displayed. 

	 The client connection status and communication status of connected devices is 
displayed. 

Indicator for the communication 
status with the connected device
  Green: Normal (comm. open)
  Red: Communication error
  Yellow: Data dropout occurred 
               and communication is retried
               (communication paused)
  No display: Communication error 
                      (comm. paused)
Double-click to display the Error 
Indicator dialog box

Displays the names of connected clients

Note
•	 If the communication status of a connected device is red, check whether a model, control 

mode, control output, or option in the Model Setting tab have the same settings as the 
connected device, and whether the communication method is correct.  

•	 Data acquisition cannot be performed when the status is red.  
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Viewing Error Detail
2.	 Double-click the status indicator under Communication Status.  The Error 

Indicator dialog box opens.

	 Up to 100 of the most recent errors are displayed for each connection.  

	 Errors are displayed in the order date/time of occurrence, error number, error 
contents, affected number, and affected system number. 

					   

	 See section 3.4 for error messages. 

Note
If a connected instrument experiences an error during communications, attempts are made to 
restore communications at the specified retry interval. If communication cannot be restored, 
the status indicator turns red. Retries are performed until communication is restored. To start 
communication manually, click the Retry Connection button. 

Reconnecting Connected Instruments
1.	 Select the instrument to reconnect. 

2.	 Click the Retry Connection button. 

	 Communication with the selected device is reopened.

2.6  Checking the Client Connection Status and Communication Status of Connected 
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2.7	 Viewing Version Information

Procedure
1.	 Click the About button or choose Help > About from the menu bar. 

	 The Version dialog box opens. 

					   

Company name

Version

User name
License number
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Chapter 3	 Functions

3.1	 Modbus Communication Device Settings

The default tag list in the Tag Settings dialog box that is displayed when you click the 
detail settings in the Model Settings tab determines the model, control mode, control 
output, and option function contents of the Model Settings tab.  
The following describes the meanings of each tag that may appear in the Tag Settings 
dialog box. 
Also, the tag names listed here are reserved.  Arbitrarily added tags cannot be used.  
therefore the same serial and model settings as the connected device must be set on 
GateCONTROL.  
•	 Serial Port Settings (as Needed)
	 Port number
	 Baud rate
	 Parity
•	 Settings for the Connected Devices (Temperature Controllers and Signal 

conditioners)
	 Serial Communications

•	 Communication protocol
•	 Baud rate
•	 Parity
•	 Stop bit
•	 Data length
•	 Communication Address

	 Ethernet Communications
•	 IP address
•	 Subnet mask
•	 Default gateway

Enter communication parameters on devices connected to GateCONTROL in advance.  
For instructions, see the user’s manual of the connected device.  

Note
The PC is connected to the instrument via an RS-232C/RS-485 converter.  The connection can 
be made using a 4-wire or 2-method.  When using the 2-wire method, disable echo back on the 
Converter.

Settings for Connected Modbus Devices 
Enter settings on the connected devices as follows.  

Setting Green Series UT1000 Series US100 VJ Series M Series
Baud rate 4800 or 9600
Parity ODD, EVEN, or NONE
Stop bit 1 1 1 1 1
Data length 8 8 8 8 8
Communication protocol 8 4 1 MODBUS, RTU mode 4
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3.2	 Meanings of Tags of Connected Devices

The default tag list in the Tag Settings dialog box that is displayed when you click the 
detail settings in the Model Settings tab determines the model, control mode, control 
output, and option function contents of the Model Settings tab.  
The following describes the meanings of each tag that may appear in the Tag Settings 
dialog box. 
Also, the tag names listed here are reserved.  Arbitrarily added tags cannot be used.  

Tag Name Meaning
PV1 Measurement input value on loop 1, or the measurement input value.  The error 

status and alarm status of PV1 or the measurement input value is added.
(See section 3.3 for information on handling error and alarm statuses.)

PV2 Measurement input value on loop 2.  The error status and alarm status of PV2 
is added. 

SP1 Target setting value used on loop 1.  SP1 related alarm statuses are added.  
SP2 Target setting value used on loop 2.  SP2 related alarm statuses are added.  
OUT1 Control output value on loop 1.  Control output value on loop 1.  OUT1 related 

alarm statuses are added.
OUT2 Control output value on loop 2.  Control output value on loop 2.  OUT2 related 

alarm statuses are added.
HOUT1 For heating/cooling control on loop 1, or the control output value for heating.  

HOUT1 related alarm statuses are added.
HOUT2 For heating/cooling control on loop 2, or the control output value for heating.   

HOUT2 related alarm statuses are added.
COUT1 For heating/cooling control on loop 1, or the control output value for cooling.  

COUT1 related alarm statuses are added.
COUT2 For heating/cooling control on loop 2, or the control output value for cooling.   

COUT2 related alarm statuses are added.
A/M1 Auto/manual mode for loop 1

0: AUTO (automatic) mode, 1: MAN (manual) mode
A/M2 Auto/manual mode for loop 2

0: AUTO (automatic) mode, 1: MAN (manual) mode
C.A.M Switch between manual/automatic/cascade

0: AUTO (automatic) mode, 1: MAN (manual) mode, 2: CAS (cascade) mode 
R/L1 Remote/local mode on loop 1.

0: Local, 1: Remote
R/L2 Remote/local mode on loop 2.

0: Local, 1: Remote
SPNO Target setting value number currently used 
PIDNO1 PID number used on loop 1
PIDNO2 PID number used on loop 2
R/S Running/Stopped status

0: Running, 1: Stopped
R/P/L Program run reset/program mode

0: Program operation reset, 1: Program operation, 2: Local operation
R/P1/P2 Program run reset/program mode

1: Program operation reset, 2: Program 1 operation, 3: Program 2 operation
HOLD Program operation pause mode

0: Program operation, 1: Program operation pause
PVEx PV event status.  x is the event number

0: Event OFF, 1: Event ON
TMEx Time event status.  x is the event number

0: Event OFF, 1: Event ON
PTNO Number of currently operating program pattern
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Tag name Meaning
SEGNO Number of currently operating segment
TIME Remaining time of currently operating segment, or time elapsed during WAIT

The units are seconds. 
LSP/CAS Local/Cascade mode

0: CAS (cascade) mode, 1: LSP (local) mode
C.A.M1 Cascade/auto/manual mode for loop 1

0: AUTO (automatic) mode, 1: MAN (manual) mode, 2: CAS (cascade) mode
C.A.M2 Cascade/auto/manual mode for loop 2

0: AUTO (automatic) mode, 1: MAN (manual) mode, 2: CAS (cascade) mode
O/C CLOSE/OPEN mode

0: CLOSE mode, 1: OPEN mode
INPUT Input value. The error status and alarm status are added.

(See specific items for information on handling error and alarm statuses.)
ADVANCE Segment forced transition

0: End of forced transition or not executed, 1: Segment forced transition
RUN Program run/stop status

0: Stopped, 1: Running

3.2  Meanings of Tags of Connected Devices
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3.3	 Details on Functions

Time Out Operation
When reading tag data, after sending a register value request message to the Modbus 
device, if the message is not received within the specified time out time that tag is 
considered to have timed out. 
For tags which have timed out, the specified number of retries are performed starting with 
the next scan interval. If there is no response from the Modbus devices corresponding to 
the tags during the specified number of retries, data reading for that tag is not performed 
thereafter. If a response is received from a Modbus device during one of the retries, the 
retry count is reset (the retry count will be 1 on the next time out).
If the retry count is 0, a retry is not performed on the tag on which a timeout occurred, 
and data reading is not performed for that tag thereafter.
The figure below shows what happens if, at retry count 2, data acquisition does not 
recover during retry.

To reopen communications after loading stops, choose the target device for 
communication in the Acquisition/Status tab, then click the Reconnect button. 

		

TAG001 TAG001 TAG001 TAG001

T T1 = T + ∆t T2 = T + ∆t x 2 T3 = T + ∆t x 3
Interval: ∆T

Timeout during 
data reading Timeout at retry 1 Timeout at retry 2 Reading stops

Timeout time Timeout time Timeout time

Time

Time

Timing of Data Reading

Note
Using GateCONTROL, data can be acquired concurrently on each COM port. Therefore data is 
logged more efficiently when connecting each device to a separate port rather than connecting 
several devices to a single port. 
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Error Status
The following shows the error statuses supported by each model.  Also, the statuses are 
modified as shown before transfer to DAQLOGGER and Remote Monitor.  

Green Series, UT100 Series, US1000
Device Data Status Data Display after Change 
PV1 A/D converter error ILLEGAL
PV1 RJC error ILLEGAL
PV1 overscale +OVER
PV1 underscale -OVER
PV2 A/D converter error ILLEGAL
PV2 RJC error ILLEGAL
PV2 overscale +OVER
PV2 underscale -OVER

VJ Series
Device Data Status Data Display after Change 
EEP error ILLEGAL
EEP sum error ILLEGAL
Low cut status -OVER
A/D burnout ILLEGAL
RJC error ILLEGAL

M Series
Device Data Status Data Display after Change 
Low cut status -OVER
Input over +OVER
Input under -OVER
EEP sum error ILLEGAL
Parameter error ILLEGAL
RJC error ILLEGAL
EEP error ILLEGAL

3.3  Details on Functions
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Processing Alarm Statuses
Each model’s alarm types are changed as follows before being sent to DAQLOGGER 
and Remote Monitor.  

Alarm Type on Device Side Alarm Type after Change
PV SP OUT, HOUT, COUT

Measured value high limit Measured value high limit [H] — —
Measured value low limit Measured value low limit [L] — —
Deviation high limit Deviation high limit [DH] — —
Deviation how limit Deviation low limit [DL] — —
De-energized on deviation high limit 
alarm

Deviation high limit [DH] — —

De-energized on deviation low limit 
alarm

Deviation low limit [DL] — —

Deviation high or low limit Other [ETC] — —
Inside deviation Other [ETC] — —
Measured value high limit de-
energizing

Measured value high limit [H] — —

Measured value low limit de-energizing Measured value low limit [L] — —
Measured value high limit 
(with idle mode)

Measured value high limit [H] — —

Measured value low limit 
(with idle mode)

Measured value low limit [L] — —

Deviation high limit 
(with idle mode)

Deviation high limit [DH] — —

Deviation low limit (with idle mode) Deviation low limit [DL] — —
De-energize on deviation high limit 
alarm (with idle mode)

Deviation high limit [DH] — —

De-energize on deviation low limit 
alarm (with idle mode)

Deviation low limit [DL] — —

Deviation high or low limit 
(with idle mode)

Other [ETC] — —

Inside deviation (with idle mode) Other [ETC] — —
Measured value high limit de-
energizing (with idle mode)

Measured value high limit [H] — —

Measured value low limit de-energizing 
(with idle mode)

Measured value low limit [L] — —

Timer function upwards 
(hour, minute)

Other [ETC] — —

Timer function downwards 
(hour, minute)

Other [ETC] — —

Timer function upwards 
(minute, second)

Other [ETC] — —

Timer function downwards 
(minute, second)

Other [ETC] — —

Sensor grounding alarm Other [ETC] — —
Fault diagnosis output Other [ETC] — —
FAIL output Other [ETC] — —
Timer function Other [ETC] — —
Timer function de-energizing Other [ETC] — —
Heater burnout alarm 1 Other [ETC] — —
Heater burnout alarm 2 Other [ETC] — —
Heater burnout Other [ETC] — —
Setting value high limit Other [ETC] Setting value high limit [H]
Setting value low limit Other [ETC] Setting value low limit [L]
Output value upper limit Other [ETC] — Output value high limit [H]
Output value low limit Other [ETC] — Output value low limit [L]
Measured value rate of change alarm Other [ETC] — —
De-energize on measured value rate of 
change alarm

Other [ETC] — —

Self diagnostic alarm Other [ETC] — —
De-energize on self diagnostic alarm Other [ETC] — —
FAIL de-energizing Other [ETC] — —

(cont. on next page)

3.3  Details on Functions
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Alarm Type on Device Side Alarm Type after Change
PV SP OUT, HOUT, COUT

Deviation high limit for setpoint Other [ETC] Deviation high limit [DH] —
Deviation low limit for setpoint Other [ETC] Deviation low limit [DL] —
De-energized on deviation high limit 
alarm for target setpoint

Other [ETC] Deviation high limit [DH] —

De-energized on deviation low limit 
alarm for target setpoint

Other [ETC] Deviation low limit [DL] —

De-energized on deviation high and 
low limits

Other [ETC] Other [ETC] —

Deviation within high and low limits for 
target setpoint

Other [ETC] Other [ETC]

Deviation high limit with stand-by 
actions for setpoint

Other [ETC] Deviation high limit [DH] —

Deviation low limit with stand-by 
actions for setpoint

Other [ETC] Deviation low limit [DL] —

De-energized on deviation high limit 
alarm with stand-by actions for target 
setpoint

Other [ETC] Deviation high limit [DH] —

De-energized on deviation low limit 
alarm with stand-by actions for target 
setpoint

Other [ETC] Deviation low limit [DL] —

Deviation high or low limit with stand-
by actions for setpoint

Other [ETC] Other [ETC] —

Deviation within high and low limits with 
stand-by actions for target setpoint

Other [ETC] Other [ETC] —

Displayed in brackets ([ ]) on DAQLOGGER and Remote Monitor. 
Furthermore, for the VJ series, all alarm types are Other [ETC].  
Alarm types are loaded from each connected device upon start of acquisition by 
GateCONTROL.  Even if alarm types are changed on the connected device after 
acquisition starts, the alarm types valid upon start of acquisition are used.  

3.3  Details on Functions
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Output Processing

		

Output request from client

Storage buffer for 
output request

Output executed Acquisition executed

Checked at 1 second intervals

Instrument

Function
•	 The output request from the client is stored in the output request storage buffer.  
•	 The output request storage buffer is checked for an output execution every second, 

and output is executed on the instrument if an output request is found.  Then, the 
output request storage buffer is cleared.  

•	 Output request storage buffer is set to hold the most recent value, so if multiple 
writings to the same tag occur during the confirmation interval, the written value 
becomes the most recent one.  

•	 An instrument is either outputting or acquiring, and acquisition execution is put on 
hold until output execution is finished, and vice versa. Therefore, acquisition or output 
execution may be delayed.  

	 Also, time may be required for output execution.  If so, it  can occur more slowly than 
the one-second confirmation interval.  

Writing of the SP Value
	 During output execution, SPNO is acquired from the instrument.  SP value output is 

executed on the register corresponding to this SPNO. 

3.3  Details on Functions
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Functions

1

2

3

Index

3.4	 Notes When Performing Communications with 
Software on Other PCs

Communications with DAQLOGGER
•	 When performing communications with DAQLOGGER, set the IP address of 

the device with which DAQLOGGER will connect on the address of the PC that 
GateCONTROL is operating, then execute automatic model determination.  

•	 On DAQLOGGER, all devices connected to GateCONTROL (temperature controllers 
and signal conditioners) are considered a single system.  Therefore, the following 
should be noted.  
•	 DAQLOGGER’s automatic model determination determines only the lowest-

numbered device if multiple devices are connected to GateCONTROL (temperature 
controllers and signal conditioners).  For determination of the other devices, specify 
the port number and system number (a number that is 1 less than the number 
in the GateCONTROL’s Model Settings tab) in the DAQLOGGER settings, then 
execute the automatic model determination function. 

•	 When connecting all devices connected to GateCONTROL to DAQLOGGER 
as one system, specify “No system number” in the address setting screen, then 
execute automatic model determination. 

Communications with DAQLOGGER Client Package
Check the port number (initial value is 50299) and system number set in GateCONTROL, 
then reconnect.  The logic behind the system numbers is the same as that for 
DAQLOGGER.  

GateCONTROL Settings
Set the same serial and model settings as the connected device on GateCONTROL.  
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3.5	 Error Messages and Corrective Actions

A message (such as an error message) may appear during operation. The following 
describes the meanings of the messages and their corrective actions. 

Error
Code Description Corrective Action
E211 Cannot write to the file. Confirm that the disc capacity and file system are correct.  
E212 Cannot read file. Confirm that a file exists, that the software supports it, and whether 

the file system is correct.  
E213 Cannot open the file. Confirm that a file exists, that the software supports it, and whether 

the file system is correct.  
E501 Invalid license number. Please reinstall. With the Gate series, the number of licenses purchased is the limit 

for the number of programs run at the same time. Reinstall the 
software. 

E1010 Execution failed. Confirm that the file is not corrupt. If this error appears repeatedly, 
reinstall the software. 

Message
Code Description
M1210 Save the setting changes and try again. 

Messages during (When Executing) Data Acquisition 
Code Description Cause/Corrective Actions
W[631] Data Lack Data was unexpectedly lost. Reduce the number of acquired data 

points or connected instruments, or lengthen the scan interval.
E[674] Communication error Communication Errors

Check whether the power to the connected measuring instruments 
with which you wish to open communications is ON, and whether 
the cables are connected correctly.  Also check the following.  
• For Ethernet
  �Is the address correct, is the TCP/IP protocol installed in 
Windows, and is the Ethernet card installed correctly? 

• For RS-232 and RS-422-A
  �Are the baud rate, port numbers (COM1–COM9), and addresses 
(RS422) correct? Is the PC serial port valid? Is the cable type 
correct?

E[675] Communication time out Communication timeout
Same as E[674].  

E[800] CRC check error CRC check error
A CRC error was detected. Check the communication status.

E[801] Invalid handle Failed to get communication handle. 
Check the communication status.

E[802] Error respond Invalid data received.  
Check the communication status.

W[880] Do not specify communication port Specify the communication parameters.  
W[881] Current connecting model 

configuration is mismatch! 
The model is:

Change the parameters for the main unit.

W[884] Retry connection Connection recovered.
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